
Chapter one 

Introduction to computer 

1.1 What is Computer? 

       Computer is the device that receives input data by input units, and 
processes these data by processing units; then either it saves the processed 
information in the storage units or outputs they by output devices.  
  In order to explain the functions that can be implemented by computer, it 
must be understood the meaning of the following words: 

1-Data  

      Data are many types of information which can be processed by computer 
such as orders, numbers, selections, pictures, sounds, etc. 

2-Processing 

   It is a method of treating the data and converting them from such form to 
another. This function is done in the processor or random memory. 

3- Output 

       It is the method of appearing the information with such a way that can 
be understood from user such as screen display, earphone, printer, etc. 

4-Storage  

        It means the save of information in computer in order to use them 
consequentially .This save may be done by CD, DVD, Flash, etc.  

5-Networks 

      They are groups of computers connected with each other where any 
computer can transmit the information to any other computer. Networks may 
be constructed from two computers or may include millions of computers. 

1.2-Use of computer 

     There are many functions that can be implemented by computer. The 
difference between computer and other devices is that the computer can do 



many task while the other devices are designed to do limited objects .For 
example, TV can be used for watching only, Radio is used for listening only, 
etc. However, there are some of simple functions that can be done by 
computer: 

i- Implementation of calculation of any company or state. 

ii- Different types of games. 

iii- Designing and printing the drawings and movements. 

iv- Printing the messages and papers. 

v- Using internet. 

vi- Engineering drawing such as 3D drawing 

vii- Programming the devices. 

viii- Arranging and giving lectures. 

ix- listening for music and watching videos. 

  Also, many other complex and simple applications can be implemented by 
computers. 

1.3 The stages of development of computer 

A- First stage (1940-1959) 

B-second stage (1959-1964) 

C-third stage (1964- beginning of seventies) 

D-fourth stage (beginning of seventies-present time) 

1.4 General types of computer 

         In general, the computers differ from each other based on their ability 
of processing the data. Some of computers have a limited ability while there 
are types of computers that have very high ability of processing the data. 
This variety of computer types makes them suitable for different 



applications and with adequate ranges of costs which can be acceptable for 
most user requirements.  

1- Central computers (Mainframe). 

         They are very big computers such as that used in banks and 
government corporations (ex. Ministry of interior). These great size 
computers cannot be bought by normal persons because of their high cost. 
They can process large amount of data such as information of millions of 
peoples. 

2- Personal computers. 

         This type can be used by normal users in houses or in work. It may be 
used for processing words, playing different games, using internet, learning, 
etc. however, this type of computers can be classified as:   

a- Desktop computers 

       This type is larger than the other type and can be put on table in the 
house or in the work.  Its cost is less than that of the other type and cannot be 
moveable because of its large size. 

b- Notebook or Laptop  

       They are small sizes of computers used at travelling. They are represent 
personal computers and they are easy in movement because of their light 
weights and because they are constructed as a unique piece. This type is run 
with recharged battery in order to be able for using at movement. Also, 
laptop can do the same functions that can be implemented by desktop 
computer with keeping the light weight and small size therefor this type has 
higher cost as compared with the first one. 

3-Servers 

          This type is used in networks to represent the main center of the 
network. It represents the place of saving and managing the network. Also, 
this type should be strong sufficiently in order to be able to manage the large 
number of computers in the network. In fact, with the development of the 



personal computers they can be used as servers and now the difference 
between personal computers and servers has decreased gradually. 

1.5 Output appearance of computer 

A-Case: 

       It is a metal box which contains the mother board. This mother board 
contains number of cards such as monitor card, sound card… etc. The output 
appearance of case consists of: 

1- Operating switches: there are two types of switches: 

i- Power switch: The main function of this switch is the connection of 
electrical current. This switch is of two types: 

a- AT switch: it is a normal switch (On-Off). 

b- ATX switch: This is a new switch where it can run the device by one 
press and then the computer can be returned to the shutting down way by 
such order from inside of the computer. 

ii- Reset: which is used for restarting the computer when such a problem has 
occurred such as when the computer cannot respond or implement any order. 
However, there are some cases that need to use the Restart switch: 

• When the computer do not respond to any order. 
• When adding any new part or device such as printer or scanner. 
• When setting up any new program in the computer. 

 
2-Drivers: 
   There are many types of drivers such as: 
i- CD-Rom 
   This is used to drive the (CDs) and it means (Compact Disk Read Only 
Memory). 
ii- Floppy Disk Driver 
    This is used to drive the floppy disks that operate with magnetic effects. 
 
 



iii- CD-Writer Driver 
      By this driver, the information can be saved in the empty disks. The 
empty disk is named as (CD-Recordable). After burn, the CD will be able to 
read only. 
Note: This driver can be used for reading and writing at the same time.      
 
iv- ZIP Driver 
    This is the responsible driver for driving the ZIP disks. These disks are 
similar to the floppy disks except that ZIP disks are larger in thickness and 
greater in the capacity of storage. 
 
v- DVD driver 
  This driver is used to drive the DVD disks which are similar to CD disks 
but DVD disks have greater capacity for storage. 
 
B- Monitor 
        It is the part of computer that can display the results of the programs 
and applications as pictures, symbols, information …etc. It represents the 
importance unit of display and it can be classified according to the cards 
such as CGA, EGA, and VGA which are old types. The new types such as 
flat screen and digital SVGA contain five switches:  
1- power (on-off) switch. 
2- Control menu switch. 
3- Right and left movement switches. 
4- Exit switch. 
 
C- Key Board 
 
       It is one of the input units which contain about 150 key. These keys 
include symbols, Arabic letters and English letters. Also, this unit contains 
many orders that can be issued to the computer. 
 
D- Mouse 
       Its size is as the fist and it has right and left sides. Also, it has a wheel at 
its center used for browsing the windows.  



1.6 Representation of data in computer 

            The computer is electronic device which has some properties such as 
the ability for saving the information, processing data and display the 
information. The computer uses electrical signal which has two states either 
it is exist or not, or, with other word, this signal may be positive (+) or 
negative (-). Therefore, the representation of data inside the computer 
depends on the use of these two states of signal which take a digital binary 
by using either number (1) or number (0). Where the number (1) represents 
the positive signal (it is existing), while, the number (0) represents the 
negative signal (it is not exist). Therefore, the information is represented by 
(Byte) which consists of the numbers (1) and (0). Knowing that, the 
numbers (1) or (0) represent one (Bit). For example, to represent the Arabic 
letter (  in the computer it will take the form (11000110) which equal to  أ (
(8) Bits. The word Bit means Binary Digital or it also may mean piece. 

1.7 Units of measuring the storage capacity in computer. 

* Bit: 

Bit is the smallest piece or unit of storage which has one of the two forms 
either (1) or (0). 

**Byte:  

    Every one Byte consists of chain of (8) Bits. The Byte may represent one 
letter or one symbol such as (?) , (!) ,….etc. 

***Kilo Byte (K.B) 

1 K.B=1024 Byte 

Or  

1 K.B≈ 103 Byte 

*** Mega Byte (M.B) 

1 M.B=1024 K.B 



Or 

1 M.B=1024 × 1024 Byte 

Or 

1M.B=106 Byte 

**** Giga Byte (G.B) 

1 G.B= 1024 M.B 

Or 

1G.B=109 Byte 

 

 



Chapter Two 

Main Computer Parts 

A computer is a machine that manipulates data according to a list of 
instructions called a program. 

 

A computer can also be defined as an electronic machine that accepts 
input (data), processes it and gives out results (information).  
The main parts of computer are as following: 

1- Hardware 
2- Software 

Hardware: 

Hardware is a collection of  physical components that make up the  
computer and the devices attached to it such as input devices, output 
devices, secondary storage devices and others.  

Hardware is composed from the following main parts: 

(1) input units  

Such examples are the keyboard, mouse and scanner. 

(2) Central Processing Unit (CPU): 

It is a metal piece with several legs installed on the motherboard and 
represents the electronic brains of the device where all the data is 
processed within this part and is called processor and depended on the 
CPU the type of computer is determined if P1, P2, P3,……etc. The 
Central Processing Unit (CUP) consists of two parts:  
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(a) Arithmetic and Logic Unit (ALU): 

 It is the unit responsible for the execution of calculations such as 
(addition, subtraction, multiplication, and division) and the logical 
processes such as( greater than, less than, equal ……..etc.). 

 (b) Control Unit 
This unit controls and supervises the work of different computer units and 
directs its work according to the program orders in order to process the 
data and controls the following processes.  
 
1- Data access from input units to main memory.  
2- Transfer data between the main memory and arithmetic and logic unit. 
3- Information exits from the main memory unit to different output units 
and secondary storage units.   
In the arithmetic and logic unit and in the control unit there is a temporary 
storage area for small amounts of data called Register such as a Program 
Counter in the control unit is used to store the address of the next 
command to be executed while a register  in the arithmetic and logic unit 
is called Accumulator and it is used for temporarily storage for data and 
the results of arithmetic and logical processes . 
   
(3) Memory unit 

The computer memory is a temporary storage area. It holds 
the data and instructions that the Central Processing Unit (CPU) needs. 
Before a program can run, the program is loaded from some storage 
medium into the memory. This allows the CPU direct access to the 
computer program. Memory is needed in all computers. 

(a) Primary Memory:- 

Primary memory also known as “main memory” or “internal memory” 
which is located in the mother board of system or as we say which is 
directly connected to the CPU. It is the place where only little bit of data 
are stored either by manufacturer or by user. 

This is further divided into two parts:- 

1- RAM 
2- ROM 
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(1) RAM 

RAM also known as “random access memory” it stores the data which 
the user currently uses or as we say it stores the data temporary in it. 
RAM needs power or electricity to work when the computer power is 
turned off then all the data in it will be erased automatically therefore it is 
called Volatile Memory . This is a circuit which has its separate space or 
slot in motherboard. This allows the computer to run the software faster. 
This memory does the following activities: 

1- Storage of computer data in the input storage area. 
2- Storage interim results of operation in the working storage area. 
3- Storage the orders of program in the program storage area. 
4- Storage final results in the output storage area.  
  
RAM is further classified into two parts 

(a) SRAM 
(b)  DRAM 

(a) SRAM: - Known as Static RAM. The word “static” refers that the 
memory retains its contents as long as the power is supplied so that’s why 
we can say this is volatile in nature. SRAM does not need to be refreshed 
periodically. SRAM is faster but more expensive than DRAM.  

(b) DRAM: - Known as Dynamic RAM. It also contains data only when 
electricity is available. DRAM needs to refresh periodically due to this, 
this RAM works slower than SRAM. Mainly general PC uses this RAM 
because it is much cheaper than SRAM and requires less space. 

(2) ROM 

ROM also Known as “Read Only Memory” as the word refers mainly it 
can only read the data which in stored in it. The information of this 
memory is usually stored by the computer manufacturer as well as  the 
information of this memory remains stored in it even after turning off the 
computer or disconnecting the power from it therefore known as non-
volatile memory  . It contains BIOS of system. 
Mainly there are three types of ROM:- 
(a) PROM 
(b) EPROM 
(c) EEPROM 
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(a) PROM: Known as “programmable Read Only memory”. In this when 
the data is stored then we have no right to change or alter any data to it. In 
this the data is written by Manufacturer company, even you can also 
purchase blank PROM chip but it can be programmed by special tool 
such as PROM programmers. In general PC’s mainly PROM is used 
because we don’t have to alter any data to it. 

(b) EPROM: Known as “Erasable PROM” as the word refers “erasable” 
means we can change or erase the data. So in EPROM we have right to 
change the data. In this we can change the data with the help of ultra 
violet rays. EPROM is much expensive than PROM.  

(c) EEPROM: Known as “Electrically Erasable PROM” the type of 
ROM which can be erased by electrical charges. EEPROM can be erased 
one byte at any time rather than erasing the entire chip by ultra violet 
rays. 

(4) Secondary Memory 

The place where we store our personal data in computer system is known 
as SM. In this we store data so that when the data is needed we can easily 
retrieve it. This is the fundamental component of comp. system. 

It is non- volatile in nature so that we cannot lose the data when power 
supply is off. 

There are two methods for accessing the data from it:- 

1. Sequential – This is the method in which we search the data 
sequentially or line by line until you find the desired data. E.g. Magnetic 
tape, etc. 

2. Direct – This is the method in which computer can go directly to the 
information that the user wants. E.g. magnetic disk, optical disk, etc. 

Now I am going to discuss some of the secondary storage devices:- 

1. Magnetic Tape: - Magnetic tape appears similar to the tape used in 
music cassettes. It is a plastic tape with magnetic coating. Mainly it 
is used to store music, movie, etc. it is not used to store data in it 
because as we know it comes under sequential access and it reads 
data line by line so that we can’t find the exact location of data. 
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2. Magnetic Disk: - This is widely used popular storage medium for 
direct access secondary storage. This is the place where data are 
automatically save when we click on save button. It is non- volatile 
so that once data is stored in it will not lose when power goes off. 

This is the storage device where we mainly store or install OS for system. 
Some of the magnetic disk are as follows:- 
Hard Disk, Floppy Disk, etc. 

(a) Hard Disk 

Hard Disk also known as “Hard Drive” or “Fixed Drive” and it is a piece 
of metal the size of a palm hand installed inside the motherboard and it 
contains all the files and data stored in the computer. Hard disk comes fix 
in our system and if you require more hard disk then it comes in 
removable also. The average computer today comes with a 250 to 500 
GB hard drive. 
Usually divides the hard disk into several parts to protect it from the risk 
of infection with the virus and the parts of this disk are called in English 
letters in sequence C:\, D:\, E:\,…….etc. 
 
(b) Floppy Disk 

This is removable, round, f lat piece of Mylar plastic, coated with a ferric 
oxide. This kind of disk is read and written by Floppy Disk Drive (FDD), 
which is a device which performs basic operations on disk including 
reading and writing of data to it. This was used to transfer data from one 
computer to another. Earlier 5 ¼” floppy disks were used but these disks 
have less storage capacity so new format of 3 1/2” floppy disk came in 
market. Now a days floppy disk are not used because off less storage and 
high rate. 

(c) Optical Disk 

This is the secondary storage medium in which you can store much more 
data in it. This is flat, circular, plastic disk coated with material. Optical 
disk is very popular because of its small size and huge storage capacity. 
You must have optical disk reader in your computer so that you can read 
or write data on it. There are two types of optical disk: 

1. CD 
2. DVD 
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CD: Known as “Compact Disk”, mainly used to store data, music, movie, 
software, etc. it can store 80 minutes of continues video recording. The 
space of CD is up to 700 MB. Due to its high storage capacity it is widely 
used. The data are store in it is in the form of “Pitts”. To avail the services 
of CD your computer should have CD drive. 

There are two types of CD: 

i- CD ROM. 
ii- CD R/W. 

 

DVD: Known as “Digital Versatile Disk”. It is high capacity storage 
medium. Mainly used to store movie, music, software, etc. the storage 
capacity of DVD is up to 4.7 GB. It looks similar to CD but due to its 
high storage capacity it is not cheaper as CD. To avail the facility of 
DVD you must have DVD drive in your computer. DVD drive also gives 
you facility to run CD disks too. Types of DVD: 

i- DVD ROM. 
ii- DVD R/W. 

(d) ZIP Disk 

It is similar to floppy disk but it is a larger in thickness and greater in the 
capacity of storage than a floppy disk.  

(e) Flash  

It is a mobile memory used to transfer data from one computer to another 
and is called commercially Flash Ram and has a storage capacity from 
64MB to 32GB. 

(5) Output Units  

One of the most important output units is the monitor where the software 
is produced in the form of images or symbols or data and other output 
units printer, speaker, ……etc. 
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Tabl1 (1): Shows the system units, output units and input units 

INPUT UNITS OUTPUT UNITS SYSTEM UNITS 

 
Mouse 
Keyboard 
Scanner 
Light Pen 
Joystick 
Microphone 

                Camera 
Barcode reader 
Finger print 
Graphics tablet 

 
 
 
 

 
Screen 
Printer 
Plotter 
Speakers 
Headphone 

 
Mother Board 
Central Processing Unit (CPU) 
Main memory (RAM / ROM) 
Hard Disk 
Floppy Disk Drive 
Laser Disk Drive 
Date Buses 
Power Supply 
Hardware Cards 
Case 

 

Software 

   Software is a set of programs, which is designed to perform a well-
defined function. A program is a sequence of instructions written to solve 
a particular problem. There are two types of software.  

1- System Software 
2- Application Software 

(1) System Software 

The system software is a collection of programs designed to operate, 
control, and extend the processing capabilities of the computer itself. 
System software is generally prepared by the computer manufacturers. 
These software products comprise of programs written in low-level 
languages, which interact with the hardware at a very basic level. System 
software serves as the interface between the hardware and the end users. 
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Some examples of system software are Operating System, Utility, 
Compilers, Interpreter, Assemblers, etc. 

(a) Operating System 
i- DOS (Disk Operating System) 
ii- Windows (Windows 3.11, Windows 95, Windows NT, Windows 98, 
Windows me, Windows 2000, Windows XP, Windows 2003……etc.) 
iii- UNIX 
iiii- LINUX 
(b) Utility Programs 
Utility programs are small systems programs that can do specific and 
simple task such as copying a file from tape to cylinder or arranging a set 
of data alphabetically or digitally. One of the type of utility programs is 
the editor program that allows the user to open a file and write programs 
or data in it.  
(c) Compilers Programs  
Compilers programs are the programs that programmers use to translate 
programs they write in a computer language such as Basic, Bascal, 
Fortran, …..etc., in order to solve a problem where these translators 
convert the main program that the programmer writes (Source Program) 
into a program written in a machine language and called (object 
program).  

 

Here is a list of some of the most prominent features of a system: 

• Close to the system 
• Fast in speed 
• Difficult to design 
• Difficult to understand 
• Less interactive 
• Smaller in size 
• Difficult to manipulate 
• Generally written in low-level language 
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(2) Application Software 

Application software products are designed to satisfy a particular need of 
a particular environment. computer lab can come under the category of 
Application software. Application software may consist of a single 
program, such as Microsoft's notepad for writing and editing a simple 
text. It may also consist of a collection of programs, often called a 
software package, which work together to accomplish a task, such as a 
spreadsheet package. 
Examples of Application software are the following: 

• Word Processing (MS Word, Lotus Word(Pro.), Word Perfect) 
• Spreadsheet (MS Excel, Lotus123) 
• Data Base (MS Access, MS SQL, Oracle) 
• Presentation (MS power Point, Flash) 
• Graphics (AutoCAD, Photoshop) 
• Web Authoring (MS Front Page) 
• Data Protection (Anti Virus ) 

 

Features of application software are as follows: 

• Close to the user 
• Easy to design 
• More interactive 
• Slow in speed 
• Generally written in high-level language 
• Easy to understand 
• Easy to manipulate and use 
• Bigger in size and requires large storage space 

Computer programming language 

   Computer programming languages any of various languages for 
expressing a set of detailed instructions for a digital computer. Such 
instructions can be executed directly when they are in the computer 
manufacturer-specific numerical form known as machine language, 
after a simple substitution process when expressed in a corresponding 
assembly language, or after translation from some “higher-level” 
language. Although there are many computer languages, relatively few 
are widely used. 
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Language Types 

(1) Machine language 

Sometimes referred to as machine code or object code, machine 
language is a collection of binary digits or bits that the computer reads 
and interprets. Machine language is the only language a computer is 
capable of understanding. 
The exact machine language for a program or action can differ by 
operating system on the computer. The specific operating system will 
dictate how a compiler writes a program or action into machine 
language. And one of the disadvantages of machine language is that it 
requires a great effort and accuracy from the programmer in addition 
to the difficulty of detecting mistakes. 
Computer programs are written in one or more programming 
languages, like C++, Java, or Visual Basic. A computer cannot 
directly understand the programming languages used to create 
computer programs, so the program code must be compiled. Once a 
program's code is compiled, the computer can understand it because 
the program's code is turned into machine language. 

Machine language example 

Below is an example of machine language (binary) for the text "Hello 
World". 

01001000 01100101 01101100 01101100 01101111 00100000 
01010111 01101111 01110010 01101100 01100100 

Below is another example of machine language (non-binary), which 
will print the letter "A" 1000 times to the computer screen. 

169 1 160 0 153 0 128 153 0 129 153 130 153 0 131 200 208 241 96 

(2) Assembly Language 

This language uses certain symbols written in English to express a 
particular order such as add and mean collect and code mult means 
multiply. This language varies from computer to another and the 
programs written in this language are called source programs and need 
a translated program called Assembler in order to convert it into 
machine language. The source program after its translation is called 
Object Program.      
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(3) High Level Languages 

A high-level language is a programming language designed to 
simplify computer programming. It is "high-level" since it is several 
steps removed from the actual code run on a computer's processor. 
High-level source code contains easy-to-read syntax that is later 
converted into a low-level language, which can be recognized and run 
by a specific CPU. 

Most common programming languages are considered high-level 
languages. Examples include: 

1. C++ 
2. C# 
3. Cobol 
4. Fortran 
5. Java 
6. JavaScript 

7. Objective C 
8. Pascal 
9. Perl 
10. PHP 
11. Python 
12. Swift 

Each of these languages uses different syntax. Some are designed for 
writing desktop software programs, while others are best-suited 
for web development. But they all are considered high-level since they 
must be processed by a compiler or interpreter before the code is 
executed. 

  code written in languages like C++ and C# must be compiled into 
machine code in order to run. The compilation process converts the 
human-readable syntax of the high-level language into low-level code 
for a specific processor. Source code written in scripting languages 
like Perl and PHP can be run through an interpreter, which converts 
the high-level code into a low-level language on-the-fly.  
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Important Tasks in Windows 

Starting computer 

  Most basic computer users only need to know a few things about 
their operating system. In these tutorials we will cover the basics of 
Windows 7. We will start with the Start menu, desktop and screen 
saver then move through the control panel and explore the topics of 
user accounts, Appearance and Themes, printers, mouse, folder 
options and sound. We will then move onto file structure and windows 
updates.  

Lets' get started with learning 
about the start menu and 
desktop. The Windows start 
menu is where you will find 
and access all of your 
programs and settings. Click 
on the Windows icon in the 
lower left corner of your 
working screen. The Windows 
7 Start Menu will look like 
this. The left hand column is a 
list of recently used programs 
and will change as you use 
your computer. The right hand 
column is where you will see 

the standard menu including 
the control panel, device and 
printer manager and help. 

    

  

  Below the left hand column is a search box. In this box you can type 
a file name, folder name, program, or extension and search for the 
location on the computer. If you do not press enter after your search 
your list of matching items will appear above the search box in the 
start menu. By clicking the magnifying glass or pressing enter a 
window will open with a list of the matching items. 

Below the right hand column start menu options is the shutdown 
button. Clicking the button will shut down the computer properly. 
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 If you would like more options click the arrow on the button to get a 
list of options. The first option is to switch users. This will keep the 
current user logged into the computer and bring you back to the sign 
in window to log into another account. Log off will log the user off 
closing all programs and return you to the sign in menu. Lock will 
lock the computer so a password will have to be entered before being 
able to log back on. Any open programs will remain open until the 
closed by the user or the computer is shutdown. Restart will log off all 
users shut down the computer and reboot it to the log in menu. Sleep 
will keep all programs running but shut down the monitor and non-
essential components of the computer. It will keep any programs open 
but will only use minimum resources to keep the computer running. 
Hibernate is used primarily for laptops. It uses even less power than 
sleep mode by placing your open work on your hard drive and turning 
your computer off with the ability to recover any open work when the 
computer is turned back on. 
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Chapter (3):   

Flowcharts and Algorithms 

(1) Introduction 

The algorithms are the hardest part in programming and when you learn it 
correctly it means that you are able to learn any programming language you 
want. In fact if you do not know how to deal with the code and address all the 
problems you face while writing the code you will give up and stop in your 
place when the first trivial problem appears to you in the code and you have 
thus wasted your time because you do not know how to solve the problem you 
are dealing with. So when you have finished analyzing your problem you can 
write it in any programming language you want with easy. 

In fact, if you really understand the algorithm, you will be able to understand 
any programming language you want because you will be able to control and 
manipulate the code the way you want.  

Algorithms are not programming language, but are the method of analysis and 
thinking that you have to follow in order to write the code correctly and 
therefore the algorithm can be defined as a set of steps or instruction arranged to 
perform a calculation or logical process sequentially and systematically.  

There are two way to represented the algorithm (Pseudo code and flowchart) as 
it will be explained later. 

In order to resolve any problem by using any high level language, there are two 
main stages as shown in the following form.  
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(2) Symbols and Idiomatic Forms in Flowcharts  

 

(1) Start/ Stop  

 

 

(2) Input/output 

 

 

(3) Calculation and Store  

 

 

(4) Decision  

 

 

 

(5) Looping  

 

 

(6) Call Subroutine  

 

 

(7) Flow Line  

 

 

(8) Connector 

 

(9) Comment 

 



(3) Algorithms (Pseudo Code) 

A formula or set of steps for solving a problem. To be an algorithm, a set of 
rules must be unambiguous and have a clear stopping point”. There may be 
more than one way to solve a problem, so there may be more than one algorithm 
for a problem. On other words, “A sequence of activities to be processed for 
getting desired output from a given input.” Then we can say that:  

 

1. Getting specified output is essential after algorithm is executed.  
2. One will get output only if algorithm stops after finite time.   
3. Activities in an algorithm to be clearly defined in other words for it to be 
unambiguous.  Before writing an algorithm for a problem, one should find out:  

• what is/are the inputs to the algorithm 
 

• what is/are expected output after running the algorithm 
 

The following symbol for different operations should be used while solving 
some problems: ‘+’ for Addition, ‘-’ for Subtraction, ‘*’ for Multiplication, ‘/’  
for Division and ‘= ’ for assignment.  

For example, A =X*3 means A will have a value 

of X*3. 

Examples of Algorithm:  

Problem1 Find the area of a Circle of radius r.  

Inputs: Radius r of the Circle and PI=3.14.  

Expected output: Area of the Circle 

Algorithm:  

Step1: start 

Step2: Read\input the Radius r of the Circle 

Step3: Input PI=3.14  

Step4: Calculate Area =PI*r*r  

Step4: Print Area 

Step5: End 

 

  

 



Problem2: Write an algorithm to read two numbers and find their sum.  
Inputs: First num1. Second num2.  
Expected output:  Sum of the two numbers.  
Algorithm:  
Step1: Start 
Step2: Read\input the first num1.  
Step3: Read\input the second num2.  
Step4: Calculate Sum =num1+num2  
Step5: Print Sum 
Step6: End 
Problem3: Write an algorithm to find the average of temperature T1, T2, and 
T3.  
Inputs: The temperature T1, T2, And T3.  
Expected output:  The average of three temperature.  
Step1: Start 
Step2: Read the values f temperature T1, T2, and T3..  
Step3: Calculate the average=(T1+T2+T3)/3  
Step4: Print the average 
Step5: End 
Type of Algorithms 
There are three types of control structure Algorithms:  

1. Sequence 
2. Branching (Selection)  
3. Loop (Repetition)  

The sequence is exemplified by sequence of statements place one after the other 
– the one above or before another gets executed first.  

The branch refers to a binary decision based on some condition. If the condition 
is true, one of the two branches is explored; if the condition is false, the other 
alternative is taken. This is usually represented by the ‘if-then’ construct in 
pseudo-codes and programs.  

Problem: write algorithm to find the greater number between two numbers 
Step1: Start  
Step2: Read/input A and B  
Step3: If A greater than B then C=A 
Step4: if B greater than A then C=B 
Step5: Print C  
Step6: End 
 
The loop allows a statement or a sequence of statements to be repeatedly 
executed based on some loop condition. It is represented by the ‘while’ and 
‘for’ constructs in most programming languages, for unbounded loops and 
bounded loops respectively. 
 



A trip around the loop is known as iteration. You must ensure that the condition 
for the termination of the looping must be satisfied after some finite number of 
iterations, otherwise it ends up as an infinite loop, a common mistake made by 
inexperienced programmers.  
Problem: Write An algorithm to calculate even numbers between 0 and 99 

1. Start 
2. I = 0  
3. Print  I in standard output 
4. I = I+2  
5. If (I <=98) then go to line 3 
6. End 

 
Note:  

(Unbounded loops refer to those whose number of iterations depends on the 

eventuality that the termination condition is satisfied; bounded loops refer to 

those whose number of iterations is known before-hand.) 

(4) Importance of Using Flowcharts 

One of the most important benefits of using the flowcharts before writing any 
program is the following things: 

1- Gives an integrated image of the steps required to solve the problem in the 
mind of the programmer so that it can fully inform all parts of the problem from 
the beginning to the end. 

2- Help the programmer to diagnose the errors that occur in the program, 
especially the logical mistakes whose discovery depends on the logical 
sequence of steps to solve the problem.  

3- Makes it easier for the programmer to make any adjustments in any part of 
the problem quickly and without having to re-examine the problem. 

4- Makes it easier for the programmer to follow the parts of the program that 
have a lot of  possibilities and branched.  

5- The flowchart used in the design of solutions to some problems are a 
reference in resolving other similar problems and a key to resolving new 
problems related to old problems resolved. 

 

 

 

       



(5) Flowcharts Types 

In general, it can be said that there are two main types of flowcharts:    

(a) System Flowcharts 

This type of flowcharts is used when designing engineering devices in factories 
and others, which use self-control systems such as buoys in water tank, traffic 
lights, and pressure control devices and temperatures in oil distillation towers so 
that the flowcharts here are considered as the complete blueprint that shows the 
order, relationship and function of each stage before and after, within the 
framework of the integrated system. 

The role of these flowcharts can be summarized as follow: 

1- It is easy to detect any malfunction in the whole system just by looking at. 
This is led to simply maintenance process and at the lowest cost. 

2- Facilitates future modification to the system program at any location. 

3- Explain the details of the data to be entered into the system. 

4- Explain the details of the types of expected or required results from the 
program prepared for the system. 

5- To indicated how to link the system to the rest of system in the designated 
organization.              

(b) Program Flowcharts 

This type of flowcharts is used to illustrate the main steps that are being 
developed to resolve a problem in the form of idiomatic drawings showing the 
logical relationship between the other steps of the solution and the location and 
function of each of them within the framework of a comprehensive solution to 
the problem.  

There are four types from program flowcharts :  
1.Simple Sequential Flowcharts 
2.Branched Flowcharts 
3.Simple-Loop Flowcharts 
4. Multi-Loop Flowcharts 
 

(1) Simple Sequential Flowcharts 
The solution steps for this type of  flowchart  are arranged in a straight series 
from the beginning of the program to the end so that it is free of branches and 
loops.  
 
 



Example 1:  Draw a flowchart to find the area and perimeter of circle have 

known radius ( R ).  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example 2: Draw a flowchart to find the values of variables A, B, and C from 
the following equations. 

1. A=X2 +2Y 

2. B=2X-3A 

3. C=A2 +XB 

 

 

 

 
 

 

 

Start 

Read   R 

PI=3.14 

A=PI* R^2 

C=2*PI*R 

Print R, 
A and C 

End 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2) Branched Flowcharts 

This type of flowcharts are used when there is a need to make a decision or a 
trade-off  between two or more choices. There are two types of resolution as 
shown below:    

 

 

In general, the branch flowcharts  can take one of the following two images: 

Start 

End 

Read 
X, Y 

 

A=X^2+2*Y 

C=A^2+X*B 

B=2*X-3*A 

Print X,Y, 
A,B, and C 

 

X?  Greater than 0 
  

Less than 0 

Equal 0 

Three branches decision 

Condition Yes No 

Two branches decision  



 

 Fig.(1) shows that if the answer of condition is (Yes) the next event in the 
execution is event (a), but if the answer is (No), the next event is event (b) either 
in Fig.(2) if the answer of condition is (Yes), the next event in the execution is 
event (a) and then followed by event (b), but if the answer of condition is (No), 
the next event will be event (b) directly.  

Example (3): 

Draw a flowchart to find the F(x) ?  

𝐹(𝑥) = �𝑥                       𝑥 ≥ 0
𝑥                        𝑥 < 0                 

 

Condition ? 

Event  b Event  a 

 

YES NO Condition ? 

Event  b 

Event  a 

YES 

NO 

Fig.(1) Fig.(2) 

READ 

 

PRINT 
X and F(X) 

X ≥0 

F(X) = -X 

YES NO 

 

START 

END 

F(x)=x 



Example (4): Draw a flowchart to find the value of W from the following equations, 
note that the value of variable X is known ?  

 

𝑊 = � 
    𝑋 + 1                       𝑋 > 0
sin(𝑋) + 5                  𝑋 = 0
2𝑋 − 1                       𝑋 < 0

 

 

 

 

 

 

 

     

 

 

 

(3) Simple-Loop Flowcharts 

This type of flowcharts we need to return a process or set of processes in the program 
a specific or unspecified number of times, and the overall form of these flowcharts is 
as follows:  

 

 

 

 

 

 

Start 

Read   X 

X? 

W=X+1 W=sin(X)+5 W=2X-1 

Print  W 

End 

Condition ? 

Event  a 

YES 

NO 

The event  is 
repeated every 
cycle until the 
answer is yes Condition ? 

Event  a 

YES 

NO 

The event  is 
repeated every 
cycle as long as 

the answer is 
yes 



And this flowchart is called a single-loop flowcharts because it uses a single rotation 
loop and is sometimes called a simple-loop flowcharts. 

Example (5): The general Traffic Directorate in Iraq is submitting a project to obtain 
online driving permits, provided that the applicant not  under 18 years of    age . Draw 
the flowchart for this project? 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

(4) Multi-Loop Flowcharts 

In this type of flowcharts the rotations are within each other so that do not intersect.   

Example (6): A merchant wants to cut off  a set of cloth sized more than 5 meters 
long into small pieces of which are 5 meters long . Draw the flowchart for this project 
?  

 

 

START 

Age ≥18 

YES 

NO 

Take person 

Grant him License 

More people? 

YES 

NO 

END 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this example we observed the presence of two loops one internal and called internal 
loop and the other is external loop and the functioning of these two loops are 
coordinated so that the priority of implementation is for internal loop.   

 

 

 

 

 

 

Is 
Remainder 

>5 

YES 

NO 

Take a piece 

Cut off 5m length 

More pieces? 

YES 

NO 

START 

END 



The Idiomatic Form For Counters 

 

 

Example (7): Draw a flowchart for program print the first ten natural numbers ? 

 

(1) 

(2) 

(3) 

i=1 

 

The process 
that will be 

returned 

i≥N 

i=i+∆ 

 

(4) 

(5) 

i=1,N,∆ 

 

The process 
that will be 

returned  

 i 

(1) 

(2) 

(3) 

Start 

Put i=1 

i≤10 

Print i 

i=i+1 
End 

Yes No 

Start 

i=1,10 

Print  i 

End 

i 



Example (8): Draw a flowchart to read the number N and find its factorial ? 

N!=N(N-1)(N-2)(N-3)……………. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example (9): Draw a flowchart to find the sum of the limits in the following amount ? 

𝑆 = �𝑎𝑖

5

𝑖=1

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example (10): Draw a flowchart to print the first thirty limits of the following series ? 

1, 3, 5, …………………………. 

 

 

 

 

 

Start 

S=0 

i=1,5 

End 

i 

S=S+a 

Print S 

Read a 



 

 

 

 

 

 

 

 

 

 

 

 

 

Example (11): Draw a flowchart to print the first two hundred  limit of the 
engineering series that it start with 5 so that the change rate is 3 ? 

 

 

 

 

 

 

 

 

 

Start 

N=N+2 

N=1 
i=1   

End 

Print N 

i<30   

i=i+1 

No 

Yes 

Start 

N=1 

i=1,30 

End 

i 

N=N+2 

Print  N 

Start 

N=N+3 

N=5 
i=1 

End 

Print  N 

i<200   

i=i+1 

No 

Yes 



Exercises: 

Q1: Draw a flowchart for work the traffic lights ? 

Q2: Write the algorithm required to find the largest number from the numbers A, B, 
and C ? 

Q3: Write the algorithm for a program that calculates the cost of the phone bill 
according to the following three rules ? 

(1) The first 50 minute: each minute with 10 DI. 

(2) The next 100 minute: each minute with 15 DI. 

(3) Whats more: each minute with 20 DI. 

Q4: Write the algorithm to find the sum of the number from 1 to 20 ? 

Q5: Draw a flowchart for the following algorithm ? 

(1) Put value of sum equal zero and value of N equal 1. 

(2) Add N to the sum  

(3) If N<6 add 1 to the current value of  N, then go to step 2. 

(4) Print value of sum. 

(5) Stop 

Q6: Draw a flowchart to find the sum m of real numbers (X1, X2, X3,…………Xm) .  

So that the result is the sum of the numbers T such that 𝑇 = ∑ 𝑋𝑖𝑚
𝑖=1  ? 

Q7: Write an algorithm to print the multiplication table for number 9? 

Q8: Write an algorithm to calculate the average numbers that the factorial result of  
last number equal to 5040? 

Q9: Draw a flowchart to find the greater common factor between two numbers? 

Q10: Draw a flowchart to find the  prime numbers for N numbers?  
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 1- Explore Window in Word 2010  

     In this section, we will know 
how to explore Window in Word 
2010. Resulting is the basic window 
which you get when you start the 
Word application. Let us know the 
various important parts of this 
window.  





Ribbon 

Tabs  

Groups  

Commands  

Title Bar Quick Access 
Toolbar 



Help Dialog box 
Launcher  

Zoom 
control  

Rulers  Status 
Bar  



View Buttons  

Print layout view   

Full screen 
analyzing view   

Web layout view   

Draft view   

Define view   



2. Backstage View in Word 2010 

    The Backstage view was 
familiarized in Word 2010. This acts 
as the central place for handling your 
documents. The backstage view helps 
in generating new documents, saving 
and opening documents, printing and 
sharing documents, and so on. 



File / Info 

First 
Column 

Second 
Column 

Third 
Column 



File / Recent 



Options Description   

Save If an existing document is opened, it will be saved as is, otherwise it will display 
a dialogue box asking for the document name.  

Save As A dialogue box will be displayed asking for document name and document 
type, by default it will save in word 2010 format with extension.docx.  

Open This option is used to open an existing word document.   

Close This option is used to close an open document.   

Info This option displays information about the opened document.   

Recent This option lists down all the recently opened documents   

New This option is used to open a new document.   

Print This option is used to print an open document.   

Save & 
Send 

This option will save an open document and will display options to send the 
document using email, etc.   

Help This option is used to get the required help about Word 2010.   

Options This option is used to set various option related to Word 2010.   

Exit Use this option to close the document and exit.   

First Column of Backstage View  



Second Column of Backstage View  

Permissions  

Compatibility 
      Mode  

Prepare for     
Sharing  

Versions  

If the file is not a native Word 
2007/2010 file, a Convert button 
appears here, enabling you to easily 
update its format. Otherwise, this 
category does not appear.  

you can use this option to defend 
your word document. You can set a 
password so that nobody can open 
your document, or you can lock the 
document so that nobody can edit 
your document.  

If the document has been saved 
several times, you may be able to 
access the previous versions of it 
from this section.  

this unit highlights significant 
information you should know about 
your document before you send it to 
others, such as a record of the edits 
you made as you developed the 
document.  



Third Column of Backstage View  

Permissions  



3. Entering Text Microsoft Word 2010  

Text Insertion Point 

It is the flashing vertical bar 
and it signifies the location 

where the text will look when 
you type.  

There is three notes : 
1- To tab text in word document , it must be use keyboard of the    
computer. 
2- You do not need to press Enter to start a new line.  
3-  When you want to add more than one space between words, use the 
Tab key instead of the spacebar.  

  



4. Move Around in Word 2010  

Keyboard  

Scroll Bars  

Scroll Down 

Vertical 
Scroll Bar 

Scroll Up 

Previous Page 

Next Page 
Browse Object 



Mouse   

Go To Command 

F 5 



5. Save Document in Word 2010  

Saving 

New 
Document 

New 
Changes 

1 2 

How can I save new changes ? 
• Just press the Ctrl + S keys. 
• Press on       in the corner. 
• Press on the option 

(File/Save)  



6. Opening a Document in Word 2010  

New 
Document 

There is three steps :- 
1. Click the File 

tab . 
2.  select the New 

option. 
3. Double-click on 

the Blank 
document . 

  

1 

2 

3 



Existing 
Document 

There is four steps :- 
1. Click the File tab . 
2.  select the Open 

option.   (This 
option opens this 
dialog box). 

3. Choose the location 
from Folders 
column. 

4. Choose the last 
chosen location 
from Folder & Files 
column.   

  



7. Closing a Document in Word 2010  

There is three steps :- 
1. Click the File tab . 
2.  select the Close 

option.   (This 
option opens this 
dialog box if you 
don’t save the 
changes previously ). 

3. Choose Save if you 
want to save, Don’t 
Save if you don’t 
want to save, or 
Cancel if you want 
to cancel the closing 
& to go back to the 
document . 

  



8. Insert Text in Word 2010  

2.   Start typing the text that  
needs to be inserted  . 

1. Click the location where 
you wish to insert text (by 
using the mouse or arrows 
of keyboard). 

  



1. Right-click the status bar and 
select the Overtype option from 
the displayed menu  . 

Click here  

Choose this option 



2. Click the location where the text needs to be 
inserted & click the new option (Insert), then 
start typing the text that needs to be inserted  . 

Choose this option 

Click 
here 

 look to the changes … 

Before   

After   



9. Select Text in Word 2010  

S. No.
  

Component   Selection Method   

1 Selecting text 
between two points  

Click at the start of the block of text, hold down 
Shift, and click at the end of the block.   

2 Selecting a single 
word   

Double-click anywhere on the word you want to 
select.   

3 Selecting a 
paragraph  

Triple-click anywhere on the paragraph you want 
to select.   

4 Selecting a sentence  Hold down the Ctrl key and click anywhere in 
the sentence you want to select.   

5 Selecting a column 
of text   

Hold down Alt, click and hold the mouse button, 
and drag over the column you want to select.   



S. No.
  

Key   
  

Selection Method   

1 Ctrl + A   Press Ctrl + A keys to select the entire document. 

2 Shift   
  

Keep pressing the Shift key and use any of the 
arrow keys to select the portion of text.   

3 F8   Press F8 and then use any of the arrows keys to 
select the portion of text.   

4 Ctrl + Shift + F8   Press Ctrl + Shift + F8 and then use any of the 
arrows keys to select column of the text.   



10. Delete Text in Word 2010  
If you want 
to delete the 
words which 
highlighted 
by green, 
follow this 
steps :-   

1- Keep the insertion 
point there (after the 
character) . 
2- press Backspace to 
delete the character. 
3- Press (Ctrl + 
Backspace) to delete 
words .  

1- Keep the insertion 
point there (before the 
character) . 
2- press Delete to delete 
the character. 
3- Press (Ctrl + Delete) 
to delete words .  



S. No.
  

Component   Selection Method  
(after selection press Backspace or Delete)  

1 Deleting text 
between two points  

Click at the start of the block of text, hold down 
Shift, and click at the end of the block.   

2 Deleting a single 
word   

Double-click anywhere on the word you want to 
select.   

3 Deleting a paragraph  Triple-click anywhere on the paragraph you want to 
select.   

4 Deleting a sentence  Hold down the Ctrl key and click anywhere in the 
sentence you want to select.   

5 Deleting a column of 
text   

Hold down Alt, click and hold the mouse button, and 
drag over the column you want to select.   

6 Deleting a Line Bring your mouse in the selection bar area and click 
in front of the line you want to delete .  

7 Deleting entire 
document content  

Press Ctrl + A keys to delete the entire document 
  



11. Move Text in Word 2010  

There is three steps :- 
1. Select the text by using any text selection methods. 
2.  take mouse pointer over the selected text and hold the 

left button of the mouse and keep holding it while 
moving around the document. 

3. Take your mouse pointer to the place where you want to 
move the selected text and release the mouse button. 
You will see that the selected text is moved to the 
desired location . 



There is four steps :- 
1. Keep both the documents opened and to ensure that 

both documents are visible, click the Arrange All button 
on the View tab on the Ribbon. 

2. Select the text by using any text selection methods. 
3.  Take your mouse pointer over the selected text and 

hold the left button of the mouse and keep holding it 
while moving around the document . 

4. Take your mouse pointer at the place in the second 
document where you want to move the selected text 
and release the mouse button. You will see that the 
selected text is moved to the desired location in the 
second document . 



Select Text  
(any text 
selection 
method) 

Right Click → 
(Copy/Cut) option 

Ribbon (Copy/Cut)  
Button  

Ctrl + (C/X) Keys  

Click at 
the place 

where 
you want 
to copy   

Ribbon Paste Button  

Ctrl + V  Keys  

Finish  

12. (Copy/Cut ) & Paste in Word 2010  

“C” for Copy, “X” for Cut 
Right Click → 
 (Paste) option 

Note: You can use the Alt + Tab keys to switch through the different documents and 
select the desired target document.  



13. Find & Replace in Word 2010  
1- Click Home tab. 
2- Click Editing group. 
3- Choice Find option (or 
press Ctrl+F), this box is 
appear. 
4- Enter a word which you 
want to explore in the Search 
box (for example “test”. 
 5- The word which is 
searched appear with highlight 
color. 
6- If you want to replace 
another word ,(“FIND TEXT” 
for example) choice Replace 
,then a dialog box is appear. 
7- Type “FIND TEXT” in the 
dialog box. 

1 2 

3 4 

5 

6 

7 



14. Spell Check in Word 2010  

What are meaning the underline beneath words in Word 2010???  
1- Red line : is meaning spelling error. 
2- Green line : is meaning grammar error. 
3- Blue line : is meaning correctly spelled but misused word. 

1- Click Review tab. 
2- Click Spelling & Grammar button. 
3- A Spelling and Grammar dialog box will appear and will display the wrong 
spellings or errors in grammar. You will also get suggestions to correct  . 
4- Select one of the given suggestions you want to use and click the Change 
option to fix the spelling or grammar mistake and repeat the step to fix all the 
spelling or grammar mistake.  
5-Word displays a dialog box when it finishes checking for spelling and grammar 
mistakes, finally Click OK.  



If you are willing to ignore a 
word, then click this button and 
Word ignores the word 
throughout the document.  

Like Ignore, but this ignores all 
occurrences of the same 
misspelling, not just once but 
throughout the document.  

Choose Add to Dictionary to add 
the word to the Word spelling 
dictionary  

this will change the wrong word 
using the suggested correct word.  

Like Change, but this 
changes all occurrences of 
the same misspelling, not 
just once but throughout 
the document.  

If you select a suggestion, 
Word creates an 
AutoCorrect entry that 
automatically corrects this 
spelling error from now 
on.  



If you will right-click 
the mouse button over 
a misspelled word, then 
it will display you the 
correct suggestions and 
the above mentioned 
options to fix the 
spelling or grammar 
mistake. Try it yourself.  



14. Zoom in/out in Word 2010  

1- Click View tab. 
2- Click Zoom in Zoom button. 
3- Zoom box is appear. This can 
show the zoom options box to 
select a price to reduce or 
increase the size of the 
document on-screen. By default, 
it will be 100%; you may pick out 
200% to increase the size of the 
font or 75% to reduce the size of 
the font . 
4- Once you are done with 
selecting an option, click OK to 
apply the changes on the 
document.  
 5- Try different options available, 
for example Page Width and Text 
Width . 

2 3 

1 

4 



Zoom Out  Zoom In  



17. Special Symbols in Word 2010 

Your keyboard may not have many 

characters available however you 

need to use the one's characters on 

your document; in such conditions, 

you have got the option to insert 

single Symbols the way we will, in 

addition, understand on this chapter. 



1. Bring your cursor to the region in which you 

want to insert the symbol. Click on the Insert 

tab. you'll find two alternatives underneath the 

image button (a) Equation and (b) Symbols. 

Equation 

Symbols 



2.When you click the Symbol button, a small 

list of symbols will appear as shown below. 

3.Now click 

on any of the 

obtainable 

symbols in the 

box to insert 

that in your 

file at the 

selected 

location. 



If you do not find 

the desired symbol 

in this small box, 

then you can click at 

the More Symbols 

option to have a 

wide range of 

symbols as shown 

below in the symbol 

dialog box. You can 

select any of the 

symbols and then 

click the Insert 

button to insert the 

selected symbol. 



You can assign a keyboard shortcut to type any 

of the available symbols. For example to assign 

Ctrl + Q key to insert the © symbol which is 

one of the available symbols in the special 

symbols list . 

There are for steps :- 

1. Click the symbol for 

which a shortcut 

key needs to be 

assigned. 

2. Click Shortcut Key 

button which will 

display the following 

Customize 

Keyboard dialog 

box. 

 



Now type the designated 

shortcut key in the 

shortcut key box. You press 

Ctrl + Q and then click the 

Assign button to assign the 

shortcut key. Lastly, use the 

Close button to close the 

dialog box. 

Now try to type Ctrl + Q 

using the keyboard directly 

and you will find that you 

are able to type © symbol 

without going into the 

symbol dialog box. 

You will see that the 

selected key 

2 

1 
3 

4 



18. Undo Changes in Word 2010  

Microsoft word offers two significant 

features were called the Undo and 

the Repeat or Redo. The Undo 

feature is used to undo the too early 

action and the Repeat or Redo 

feature is used to repeat the 

previous action.  



You can access the Undo and Repeat 

buttons from the Quick Access toolbar.  

Click the Repeat 

(Redo) button 



let us delete the last word operation 

character by character.  

Click the Undo 

button one by one 



Note that if the previous action was Undo, Ctrl+Y redoes the Undo one 

action. 
 

S. No.

  

Key   

  

Operation  

1 Ctrl + Z  Undoes the previous action. 

2 Ctrl + Y   

  

Repeats the previous action. 



19. Setting Text Fonts in Word 2010  

Microsoft word lets you to use set of 

fonts with different size. You can alter 

your document's look by changing 

the fonts and their size. 



There are four steps :- 

1. Select the area of text. 

2. Click the Home tab.  

3. Click the Font Type 

button. 

4. Select and click over the 

font name in the list. 

Change 

Font 
Type 

Font Size 

There are four steps :- 

1. Select the area of text. 

2. Click the Home tab.  

3. Click the Font Size button. 

4. Select and click over the 

font size in the list. 





The Shrink Font button can be used to 

reduce the font size whereas the Grow 

Font button can be used to enlarge the 

font size.  



All of the setting can be reset to plain text, 

or the default formatting. To reset text to 

default settings. 

There are three steps :- 

1. Select the area 

of text. 

2. Click the Home 

tab.  

3. Click the Clear 

Formatting 

button, or use 

Ctrl + 

SPACEBAR. 

Clear Formatting button 



20. Decoration in Word 2010 

When we use the term decorate, it means decorate by 

placing the text in italics, underlining the text or making it 

bold to look more fancy and much more. 

There are three steps :- 

1. Select the area 

of text. 

2. Click the Home 

tab.  

3. Click the Bold [ 

B ] button, or 

use Ctrl + B 

keys. 



An italic text looks with a small inclination and 

we use the italicized text to distinguish it from 

other text. 

There are three steps :- 

1. Select the area 

of text. 

2. Click the Home 

tab.  

3. Click the Italic [ 

I ] button, or 

use Ctrl + I 

keys. 



An underlined portion of text looks with an 

underline and we use the underlined portion of 

text to make it more distinguished from other text. 

There are three steps :- 

1. Select the area 

of text. 

2. Click the Home 

tab.  

3. Click the 

Underline [ U 

]button, or use 

Ctrl + U keys. 



Strikethrough portion of text will look as if a line has been 

drawn through the middle of it. A strikethrough portion of 

text shows that it has been deleted and that the portion of 

text is not essential any more. 

There are three steps :- 

1. Select the area 

of text. 

2. Click the Home 

tab.  

3. Click the 

Strikethrough [ 

abc ] button. 



21. Change Text Case in Word 2010 

You can also exploit a character you are typing by pressing 

and holding the SHIFT key while you type. You can also 

press the CAPS LOCK to have every letter that you type 

capitalized, and then press the CAPS LOCK again to turn 

off capitalization 

There are four steps :- 

1. Select the area of 

text. 

2. Click the Home 

tab.  

3. Click the Change 

Case button. 

4. Select the 

Sentence Case 

option. 



Changing text to lowercase is where every word of a 

sentence is in lowercase.  

There are four steps :- 

1. Select the area of 

text. 

2. Click the Home 

tab.  

3. Click the Change 

Case button. 

4. Select the 

Lowercase 

option. 



This is where every word of a sentence is in uppercase. 

There are four steps :- 

1. Select the area of 

text. 

2. Click the Home 

tab.  

3. Click the Change 

Case button. 

4. Select the 

UPPERCASE 

option. 



A capitalize case is the case where every single first character 

of every single selected word is in capital. 

There are four steps :- 

1. Select the area 

of text. 

2. Click the Home 

tab.  

3. Click the 

Change Case 

button. 

4. Select the 

Capitalize Each 

Word option. 



The Toggle operation will alter the case of every single 

character in reverse way.  

There are four steps :- 

1. Select the area 

of text. 

2. Click the Home 

tab.  

3. Click the 

Change Case 

button. 

4. Select the 

tOGGLE cASE 

option. 



22. Change Text Color in Word 2010  

You can every time change the color of the font to a color of 

your choice.  

1. Select the area of text. 

2. Click the Font Color 

button triangle to show a list 

of colors. You can select any 

of the colors available by 

merely clicking over it. 

If you do not find a color 

of your choice, you can 

use the More Colors 

choice to show the color 

pallet box which lets you 

to select a color from a 

range of colors. 



Typically we highlight a text using yellow color. 

1. Select the area of text. 

2. Click the Text Highlight 

Color button triangle to 

show a list of colors. Try to 

change your mouse pointer 

over different colors and 

you will see the text color 

variations automatically. You 

can select any of the colors 

accessible by simply clicking 

over it. 



Cover page or the headings of the document. 

1. Select the area of text. 

2. Click the Text Effect 

button to display a list of 

effects comprising shadow, 

outline, glow, reflection etc.. 

You can select any of the 

text effect accessible by 

simply clicking over it. 



23. Text Alignments in Word 2010  

A paragraph's text is left aligned when it is aligned 

consistently along the left margin. 

Click anywhere on the 

paragraph you want to 

align and click the Align 

Text Left button 

available on the Home 

tab or simply press the 

Ctrl + L keys. 



A paragraph's text will be said center aligned if it is in the 

center of the left and right margins.  

Click anywhere on the 

paragraph you want to 

align and click the 

Center button available 

on the Home tab or 

simply press the Ctrl + 

E keys. 



A paragraph's text is right-aligned when it is aligned 

consistently along the right margin. 

Click anywhere on the 

paragraph you want to 

align and click the Align 

Text Right button 

available on the Home 

tab or simply press the 

Ctrl +R keys. 



A paragraph's text is justified when it is aligned consistently 

along both the left and the right margins 

Click anywhere on the 

paragraph you want to 

align and click Justify 

button available on the 

Home tab or simply 

press the Ctrl +J keys. 

When you click the 

Justify button, it shows 

four options, justify, justify 

low, justify high and justify 

medium. You need to 

choice only the justify 

option.  



24. Indent Paragraphs in Word 2010  

Left indentation means to change the left edge of the 

paragraph inward towards the center of the paragraph.  

Click anywhere on the 

paragraph you want to 

align and click Increase 

Indent button available 

on the Home tab or 

simply press the Ctrl +M 

keys. 

You can get rid of left 

indentation by clicking 

the Decrease Indent 

button available on Home 

tab or simply press Ctrl 

+ Shift+ M keys. 



Right indentation means to change the right edge of the 

paragraph inward towards the center of the paragraph.  

Click anywhere on the 

paragraph you want to 

align and click Increase 

Right Indent button 

available on the  

Page Layout tab. 

You can take out right 

indentation by clicking 

the Decrease Right 

Indent spinner in the 

opposite direction. 



25. Create Bullets in Word 2010 
Microsoft word offers bullets and numbers to put a list of 

items in a fine order. 

There are three steps :- 

1. Select a list of text to 

which you want to 

assign bullets or 

numbers. 

2. Click Bullet Button 

triangle.   

3. Choice any of the bullet 

style accessible by 

simply clicking over it. 

If you are willing to create a list with 

numbers, then click the Numbering 

Button triangle instead of the bullet 

button to show a list of numbers 

you want to assign to the list.  



There are four steps :- 

1. Type * 

2.  Either press the 

SPACEBAR or press 

the TAB key.   

3. Type the rest of what 

you want in the first 

item. 

4. press Enter to add the 

item in the list 

automatically and go to 

add next item in the 

list. 

 



26. Set Line Spacing in Word 2010 
Line spacing is the space between two lines in a Microsoft 

Word document. You can increase or decrease this space 

as per your necessity. 

There are three steps :- 

1. Select a paragraph 

or paragraphs for 

which you want to 

define spacing. 

2. Click the Line and 

Paragraph Spacing 

Button triangle. 

3. Select any of the 

option available by 

simply clicking over 

it. 



27. Borders and Shades in Word 2010 
Microsoft Word lets you to place a border on any or all of 

the four sides of selected text, paragraphs, and pages. You 

can also add different shades to the space taken by the 

selected text, paragraphs, and pages.  

There are three steps :- 

1. Select the portion of text or paragraph to which 

you want to add border.  

2. Click the Border Button.   

3. Try to add dissimilar borders like left, right top or 

bottom by choosing diverse choices from the 

border options. 



Select outside 

Borders  

To delete the present border, by select the No Border option 

from the border options. 



 

There are three steps :- 

1. Click the Border Button. 

2. Select the Border and Shading 

option obtainable at the 

bottom of the list of options. 

3. Click the Page Border tab 

which will show a list of 

border settings, styles and 

options whether this border 

should be applied to the whole 

document or just one page or 

the first page. 

 

 

 



You can modify your border by setting its color, width by 

using different art available under the style section. 

You can have 

similar borders 



28. Header and Footer in Word 2010 
Headers and footers are parts of a file that contain special 

information such as page numbers and the total number of 

pages, the document title, company logo, any photo, etc.  

 

There are three steps :- 

1. Click the Insert tab. 

2. Click the Header 

button, it will display 

a list of built-in 

Headers. 

3. Choose any of the 

headers by simply 

clicking on it. 

 

 

 



Once you choose any of the headers, it will be applied to the 

document in editable mode and the text in your document will look 

dimmed. 

 

Click Close 

Header and Footer 

You can follow a similar procedure to add footer in your document. 



1. Click the Insert tab. 

2. Click either the Header 

button or Footer button. 

3. Click on the Edit Header 

option. 



Now you can edit your 

file header and once 

you are done, click 

Close Header and 

Footer to come out of 

the edit header mode. 

You can follow a alike process to edit the footer in your document. 



29. Add Page Numbers in Word 2010 
Microsoft Word automatically allocates page numbers on the 

pages of your document. Normally, page numbers are printed 

either in header or footer but you have the choice that can 

show the page number in the left or right margins at the top or 

the bottom of a page. 

1. Click the Insert tab. 

2. Click the Page Number 

button available in the header 

and footer section. 



For Example, when I take the mouse pointer at the 

Bottom of Page option it shows the resulting list of 

styles 

Selected the Accent Bar 1 

style by clicking over it. 



There are three steps :- 

1. Click the Insert 

tab. 

2. Click the Page 

Number button 

accessible in the 

header and footer 

section.  

3. Remove Page 

Numbers option. 

Just click this 

option. 



30. Create a Table in Word 2010 

A table is a structure of vertical columns and horizontal 

rows with a cell at every intersection. Each cell can include 

text or graphics. 

1. Click the Insert tab 

followed by the Table button. 

2. You can make your table 

having the desired number of 

rows and columns. 



4. Click the Table Styles button to show a gallery of table styles. 

3. Click the square on behalf of the lower-right corner of your 

table. 

Click the built-in 

table style. 



There are three steps 

:- 

1. Click 

anywhere in 

the table. 

2. Click the 

Layout tab.  

3. Click the 

Delete Table 

option. 



31. Rows & Columns in Word 2010 

A Word table can contain as many as 63 columns but the 

number of rows is unlimited.  

1. Click a row where you 

want to add an additional 

row. 

2. Click the Layout tab. 



3.Use the Row & Column group of buttons to add any row 

below or above to the selected row.  

Click the Insert 

Below button, 

it will add a 

row just below 

the selected 

row. 



There are three steps :- 

1. Click a row which you want to delete . 

2. Click the Layout tab. 

3. Click the Delete Rows option under the Delete Table Button.  

delete the 

selected row. 



1. Click a column 

where you want to 

add an additional 

column . 

2. click the Layout 

tab. 

3.  Use Row & Column 

group of buttons to add any 

column to the left or right 

of the selected column. 

add a column 

just left. 



There are three steps :- 

1. Click a column which you want to delete . 

2. Click the Layout tab. 

3. Click the Delete Column option under the Delete Table Button. 

delete the selected 

column. 



32. Merging Cells in Word 2010  

Microsoft Word lets the merging of two or more cells to 

create one big cell. 

There are three steps :- 

1. Get your mouse pointer position inside the first cell. 

2. Press the Shift key and click the cells around the cell which you 

want to merge into the first cell. 

3. Click the Layout tab and then click the Merge Cells button. 

merge all the 

selected cells. 



Once merging the cells, all the content of the cells will be twisted 

which you can fix later as you like. 
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